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WindowsCE 6.0 Developer's Guide 

Description: 

S3C6410-TFAsoftware and S3C6410-TFA is fully compatible, so the path is set, the default configuration files, 

etc., have followed the S3C6410-TFA of manuals, based on the actual situation may be slightly different, if in 

doubt, please contact us. 

1.1 Experience WindowsCE6 

WindowsCE6 the programming file in the CD "\ images \ WindowsCE6" directory. Follow the "Brush Guide" in 

the methods and steps you need to download the programming system (this example is programmed 

NK_T43-i.bin, it applies to the use of first-line precision touch of the 4.3 "LCD), installed, please set the S2 

switch development board for the Nand Flash boot the system, start-up screen shown in Figure. 

 

1.1.1 touch screen calibration 

The default installation of the wince system's touch screen calibration parameters are generally applicable to 

NEC 4.3 "LCD, touch screen, but because the physical characteristics of each different, and sometimes may not 

be accurate, especially when the different sizes, then you need to re-calibration, the following steps : 

Please connect a USB mouse, point to Start -> Settings -> Control Panel, find the "stylus" icon, double-click to 

open "stylus Properties" window, point "calibration" tab of the "recalibration" button to start the re-calibration 

. 



 

 

 

According to the system prompt, use the five-point calibration method starting with the touch pen calibration, 

calibration is completed, the following window will pop up, then just point a position to return to the "stylus 

Properties" window, click "OK" to save and exit. 

 

If you want to save this calibration parameters, please click "Start -> suspend", then reboot it. 

 

1.1.2 The effect of the touch screen to write validation 

WinCE system is installed by default on the desktop with a small brush program: Painter, you can use it to test 

the accuracy of the touch screen, since the use of the touch-line precision, you can see the effect of writing is 

very accurate, no glitches, but also not shake. 



 

 

 

1.1.3 View System Information 

Click "Start" -> "Settings" -> "Control Panel" -> "System", you can open to view system information, as shown in 

Figure. You can also right point on the desktop "My Device" -> "Properties" (press and hold the stylus often, the 

effect can be achieved right). 

 

1.1.4 Real-time clock and save the settings 

The time point of the task bar bottom right corner, there to set the time window can be set according to the 

prompts, and set up, click "OK" to exit, do not point to set the time to "hang" to save. 

 



 

 

 

1.1.5 The user memory space 

Open the "My Device" you can see a file called "NandFlash" disk drive, the data can be saved on the inside, the 

contents of the directory is not lost power-down, as shown in Figure. 

 

1.1.6 use the USB and SD card 

In wince use flash drives and USB flash drives use a standard similar to the windows, when WINCE system 

starts, the flash drive into the USB Host interface, then the board to the USB power supply, USB light flashes, 

the system waits a few seconds automatically loaded on a flash drive, then you can double-click the desktop 

"My Device" icon, open Explorer, you can see USB drive letter: drive, double-click the hard drive can read and 

write the data into the flash drive.The SD / MMC card into the SD slot board, Explorer, you can see the SD card 

drive letter: Storage Card, double-click to open access to the directory, you can SD / MMC card read and write 

the. 



 

 

 

 

 

 

1.1.7 mp3 player 

Wince comes with MediaPlayer player can play mp3, as shown in Figure 

 

 

1.1.8 Test LED 

Open Desktop's "Pardazesh Sabz" program group, and find the "LED-Test", double click to run it, as shown, you 

can point interface to the control panel buttons on the four LED's light off. 

 



 

 

1.1.9 Test button 

Open Desktop's "Pardazesh Sabz" program group, and find the "Buttons", double click to run it, as shown, then 

press the key development board, you can see the corresponding icon on the program interface turns blue. 

 

1.1.10 Test PWM control buzzer 

Open Desktop's "Pardazesh Sabz" program group, and find the "PWM-Buzzer", double click to run it, figure, 

point "Start" button to test the buzzer, the point "Stop" to stop the buzzer sounds. 

 

1.1.11 Recording Test 

Open Desktop's "Pardazesh Sabz" program group, and find the "PWM-Buzzer", double click to run it, as shown 

in Figure 



 

 

 

 

When prompted, click "Record" button to start recording, then the microphone to speak against the board, the 

program to start recording, click "Stop" button to end the recording, as shown: 

 

At this point you can click "Play" button will just loop recording. Note: The audio recording program does not 

save the results. 

1.1.12 serial Assistant 

Description: This development board provides a standard BSP includes three serial ports driver, respectively, 

COM2, 3,4, and the COM1 serial port function driver was not ordinary available to test these three serial ports, 

need to use a null modem serial cable to connect the development board COM1, 2,3 three DB9 serial port can 

be. 

In the "Pardazesh Sabz" program group click on Run "SerialPort", run the interface like the left figure below, 

 

Point "Settings" button, open the Settings window, set the serial number is COM2, 115200 baud, other settings 

shown (top right), point to determine the return to the main window. 



 

 

At the same time, connected to a PC expansion board COM2 end, and in the PC serial port to the appropriate 

setting for the same. The midpoint of the main window "open port" button, then the button will change to 

"Close port" in the "Send area" Enter some characters, click "Send" button, like the left figure below, when the 

serial port on the PC side will end received from the development board to send 

To the character, such as the lower right: 

 

Then, in the main window of serial debugging aides point "receive" button (the button will change to "no 

access"), in the PC serial port terminal input some characters (via HyperTerminal can not see), the input at the 

same time, Enter the characters we see in the development board serial debugging aides reception area 

displays, as shown: 

 

We can also use the same method to test COM3, 4, this is not described in detail. 

1.1.13 hard decoding player 

Most of the 6410 development board demonstration multimedia player used the "Iron Man," "Shrek," 

"Wanted," those old films, and there is no sound output, because that Samsung provides test procedures, using 

a special high-definition film format , just to test the video decoding, can not directly play common movies 

properly, and now in 6410 we achieved a more powerful platform hardware decoding of universal player, it can 

support 720x480 30fps or 720x576 25fps playback hardware decoding Mpeg4, H264, H263 and other video, the 

effect is extraordinary! (We also implemented the first Linux platform hardware decoding player). 

And with the same name than the other version of the player, this version has the advantage of: 

- You can automatically identify Mpeg4, H264, H263 video format and automatically switch to decode and play 

hard, that is, 

 



 

 

Said that if you drive in the 6410 platform, there is no driver support for hardware decoding, but also can play, 

just not good enough in the playback 

- Play some of the movie phenomenon of not Huaping 

- Draw the final picture using DirectDraw technology, better 

The player has now been integrated into the default installation of WinCE system, in order to facilitate user 

testing, we specialize in two test videos, they are in "disc B \ test video" directory, you can copy it to SD card 

use, one of which is encoded in H.264 format video, and the other using MPEG4 format. 

Open Desktop "super player" program, as shown in Figure 

Note: The newly installed system for the first time wince open this program will slow 

 

Point "File" -> "Open File" to find your own SD card or other video files, as shown in Figure 

 

Select the file, you can watch the movie to play hard decoding. 

 

Caution: Since 6410 the largest hard-decode only supports 720x480 player, so when in full-screen 7-inch 



 

 

Slightly cards, then you can click "Options" -> "Zoom" -> "100%" and "Options" -> "aspect ratio" - the "original", 

and then full-screen button, when using 4.3 "LCD or other resolution LCD playback, choose your own scale 

based on the actual situation, until the best results. 

1.1.14 TV-OUT test 

Open Desktop's "Pardazesh Sabz" program group, and find the "multimedia-test", double click to run it, as 

shown in Figure. 

 

At this point the TV input is set to CVBS, and between the target board using the yellow video cable connected, 

point "TV", the output on the LCD disappears, the screen to the TV, as shown in Figure. 

 

On this screen, then click open "TV" test program, choose "LCD" can be restored to the LCD display. 

1.1.15 Set the Ethernet MAC address 

As min6410 not on the DM9000 Ethernet card with the MAC address, therefore, strongly recommended that 

re-program the system, first use the network feature, you manually set a MAC address, to avoid the emergence 

of multiple LAN MAC address the same result network instability, especially if you purchase a multi-block 

development board, and they are also connected to the same LAN case, should set the MAC address, because 

they are factory MAC address is the same. 

 



 

 

 

 

Use MAC address setting tool to set the MAC address, the MAC address is saved to the registry, but unless you 

re-program the 

System, or just need to set up once. 

Click the icon to start the following iMAC MAC Address address setting tool: 

 

MAC Address address setting tool starts, the interface as shown below, at the interface, Old behind the text 

box shows the current 

MAC address, MAC address you want to modify, in New behind the text box to enter a new MAC address, for 

simplicity, the tool provides a "Gen" button, click it will output a random MAC address for you, the MAC 

address the use of time as random seed, so in general does not output the same MAC address: 

 

The following figure is to click the "Gen" button results in the New text box outputs a new MAC address: 



 

 

 

Click "Update MAC" button to save the MAC address to the registry and prompt you to restart the development 

board: 

 

The development board after reboot, MAC address, it will come into force. 

1.1.16 Set the network parameters to connect to the Internet 

Only by correctly setting the IP address and gateway and DNS and other parameters, we can use the 

development board using the Internet or LAN connection. 

The steps to set network parameters and the standard Windows system is very similar to the point "Start" -> 

"Control Panel", find the network settings options, and find the corresponding card DM9CE1 Fig. 



 

 

 

Double-click to open DM9CE1 icon, as shown, where you can set a static IP address, you can also set up 

dynamic IP way, according to the network environment where you can fill in the actual parameters, as shown in 

the default configuration parameters. 

 

Determine the correct network setting parameters, you can open a browser on the Internet. 

 

1.1.17 use the SD wireless card 

Before turning it on, the SD-WiFi module is first received the SDIO pin development board seat, that is, CON11, 

Fig. 

 



 

 

 

 

After the system starts, SD WiFi module on the green light will stop flashing, if the wireless access point nearby, 

the system will automatically set up the wireless network window, shown in Figure 

 

Select a wireless network connection point, began to set up a wireless network, according to their actual 

situation, select the encryption type, and enter the password, as shown in Figure. 

 

 

Point the upper right corner of the "OK" to return, set message window will appear to connect, the connection 

is successful, as shown. 

 



 

 

 

1.1.18 use a USB wireless card 

The development board default WinCE system integrates Ralink RT2070/RT3070 USB wireless network card 

drivers, wireless network card driver, so you can directly plug in to use interface and SD WiFi settings are 

identical, when plugged into the USB wireless network card is the emergence of the following Set interface: 

 

Other settings and SD WiFi is exactly the same, not repeat them here. 

1.1.20 use a USB Bluetooth 

The default WinCE system development board integrates USB Bluetooth driver, it is not third-party drivers, but 

that comes with WinCE components, so you just look a little configuration you can use, we provide examples of 

projects have been added The configuration options, so you can plug in the USB Bluetooth adapter, a 

description is that the driver has some limitations, does not support all Bluetooth adapter module. 

WinCE system comes with the software, you can phone or other Bluetooth devices to send files to the board 

the following, we describe the use of detailed steps: 

 



 

 

 

The Bluetooth module into the development board, open the "Control Panel" -> "Bluetooth Device Properties", 

as shown: 

 

Point "Scan Device" to begin scanning for Bluetooth devices nearby, the results shown here is my cell phone 

found the device: 

 

Point "Æ" to add this device to the trusted list, such a dialog box will appear: 

 



 

 

 

Point "is", there will be a PIN authentication dialog box, just enter a few numbers, such as "111", then the 

mobile terminal a request dialog box appears, enter the same "111", the trusted device is added to the right , 

as shown: 

 

Thus, we set up the development of trust between the board and mobile channels, this time, the phone sends a 

file to the board, the development board will be receiving such a request: 

 

Point "is" to accept the request to send the file to the development board will be receiving the "Documents \ 

DefaultInbox" directory. 

1.1.21 backlight adjustment control 

If your system is pre-installed WindowsCE6, perhaps you have noticed, almost half a minute if you did not click 

on the touch screen, LCD backlight will gradually go out, this is the default system built-in functions. 

Only use first-line precision touch 4.3 ", 7" LCD module, it has a backlight adjustment circuit, in the WindowsCE 

system, backlight adjustment part of the drive system uses a standard interface, so you can easily be 

programmed to control them. 

To set the backlight system, open the "Control Panel" -> "show", as shown: 



 

 

 

Point "background light" frame, as shown, you can set the background in this light off delay time, default is 30 

seconds. 

 

And then point below the "Advanced" button (to hide the task bar) 

 

Backlight adjustment window appears, as shown: 

 



 

 

 

Here, you can slide left and right buttons, adjust the LCD backlight, point "close" to return on an interface. 

1.1.22 Synchronization with PC (based on Windows7) 

Note: In Windows 7 system, without having to install the ActiveSync software!But the need to ensure that you 

are using Windows7 on the Internet, because the installation of "Windows Mobile Device Center" will 

automatically download files from the network. Windows 7 system, the development board and PC 

synchronization is "Windows Mobile Device Center" (the 

Called "Sync Center") and managed to achieve, which is similar to the previous ActiveSync, its interface is 

shown. 

 

"Sync Center" is not built-in Windows 7, but for the first time to connect mobile devices to download via the 

Internet security 

Installed, the following are the detailed steps. 

Note: If the development board installed WinCE6, users can still ActiveSync Windows XP system 

Connected, the specific steps you can refer to the old version of user manual, the steps described in this only 

applies to Windows 7. 

  Windows Mobile Device Center installed a PC synchronization 

When the development board WinCE6 system installed and running, the first Windows 7-based PC system by 

USB connection window will pop up as shown in Figure 



 

 

 

Soon, it will appear in the following prompt window on your desktop 

 

This time to ensure that your network and Internet connectivity is, the system will automatically download and 

install the relevant software configuration, as shown in Figure 

 

Installed, the following interface configuration start automatically 

 

 

The "Software License Agreement" window, click "Accept" to continue 



 

 

 

Soon after, and development board on the success of the device is connected, as shown in Figure 

 

Point "is not set to connect" button, to continue, the interface appears as shown in Figure 

 

At this point, the point "document management" and "Browse the contents of the device" will be the same as 

the open directory open the root directory of the development board, if 

Plug the USB development board or the SD card, USB flash drives will be the same as a corresponding icon. 

 



 

 

 

Here, we open the "\" folder, it represents the entire contents of the directory board, as shown, then, you can 

drag Copy to the development board to put the file, of course, you can read files from the development board. 

 

2 Create a WindowsCE 6.0 development environment 

Note: The following steps are based on software and systems Microsoft Windows 7 (Ultimate), other 

WindowsSystem tested.Recommended to install the software onto the hard disk installation (ISO CD image 

file can use the virtual CD-ROM) 



 

 

 

Windows CE 6.0 installation process is very cumbersome, and the requirements for the development of the 

host higher (or will be very slow), we recommend that users, especially beginners must be installed in 

accordance with the steps we describe the development environment. 

Here we use is the key to the development of host configuration, for reference: 

CPU: Intel Core Duo E8400 Memory: DDR2 4GB hard disk space: 500GB 

Install the required software listed below (the company does not provide Windows Embedded 6.0 CE 6 

installation files, the user can go to the Microsoft website to download a trial version of it): 

 Visual Studio 2005 (trial version download: 

http://download.microsoft.com/download/e/1/4/e1405d9e-47e3-404c-8b09-

489437b27fb0/En_vs_2005_Pro_90_Trial.img) 

 Visual Studio 2005 Service Pack 1 (File name: VS80sp1-KB926601-X86-ENU.exe)Download: 

http://www.microsoft.com/downloads/details.aspx?familyid=bb4a75ab-e2d4-4c96-b39 d-37baf6b5b1dc & 

displaylang = en 

 Visual Studio 2005 Service Pack 1 Update for Windows Vista 

(File name: VS80sp1-KB932232-X86-ENU.exe)Download: 

http://www.microsoft.com/downloads/details.aspx?FamilyID=90E2942D-3AD1-4873- A2EE4ACC0AACE5B6 & 

displaylang = en) 

 Visual Studio 2005 Service Pack 1 ATL Security Update 

(File name: VS80sp1-KB971090-X86-INTL.exe)Download: 

http://www.microsoft.com/downloads/details.aspx?familyid=7C8729DC-06A2-4538- A90D-FF9464DC0197 & 

displaylang = en 



 

 

 Windows Embedded CE 6.0Trial Download: 

http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=7e2868 

47-6e06-4a0c-8cac-ca7d4c09cb56 

 

 Windows Embedded CE 6.0 Platform Builder Service Pack 1Download: 

http://www.microsoft.com/downloads/details.aspx?FamilyId=BF0DC0E3-8575-4860- A8E3-290ADF242678 & 

displaylang = en 

 Windows Embedded CE 6.0 R2Download: 

http://www.microsoft.com/downloads/details.aspx?FamilyId=F41FC7C1-F0F4-4FD6-9366-B61E0AB59565 & 

displaylang = en 

 Windows Embedded CE 6.0 R3Download: 

http://www.microsoft.com/downloads/details.aspx?FamilyID=BC247D88-DDB6-4D4A-A595-8EEE3556FE46 & 

displaylang = ja & displaylang = en 

 Tencent QQ (third-party software)Download: 

http://www.microsoft.com/downloads/details.aspx?FamilyID=527042f7-bb5b-4831-a6ad5081808824ec & 

displaylang = en 

 WesttekFileViewers6.exe (office document viewer, which are covered by third-partysoftware)Download: 

http://www.microsoft.com/downloads/details.aspx?FamilyID=d2fd14eb-7d5c-428b-951c-343f910047c1 & 

displaylang = en 

The above list also shows the basic sequence of installation of the software in order: first install Visual Studio 

2005 and the patch, then install Windows CE 6.0 and the patch, and finally install third-party software. 

Description: Windows CE 6.0 Platform Builder and used in previous Windows CE 5.0/4.2 etc different, it is not 

an independent software development platform, but as a plug-in to VS2005 installed, so you must first install 

VS2005, after compile all the kernel configuration for such development are based on the VS2005. 

Here are the detailed steps. 

2.2.1 Installing Visual Studio 2005 and patch 

Step1: Open Visual Studio 2005 folder, find the setup.exe, double click to start the installation. 



 

 

 

Step2: in Figure interface point "Install Visual Studio 2005", continue 



 

 

 

Step3: in Figure interface, wait a moment,, "Next" to continue 

 

 

 

 

 

 

 

 



 

 

 

Step4: in Figure interface, pay attention to click the red box, and enter the serial number, "Next" to continue 

 



 

 

 

Step5: in Figure interface, select the installation type, select the full installation in this, that "Full",, "Next" to 

continue 

 



 

 

 

Step6: in Figure interface, officially installed Visual Studio 2005, this process is longer, please be patient. 

 



 

 

 

Step7: Visual Studio 2005 installed, the following screen appears, point "Finish" to complete the installation. 

 

 



 

 

 



 

 

 

Will appear as shown in Figure interface point "Exit" to exit. 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

Step8: now install the first patch file Visual Studio 2005 Service Pack 1, double-click operation  

VS80sp1-KB926601-X86-ENU.exe to start the installation, the interface appears as shown in Figure 

 

 

 

Step9: must wait a moment, appears in Figure picture, click "OK" officially installed 



 

 

 

 

 

Step10: Install the license agreement to accept the point "I accept" to continue 

 

Step11: The installation process interface, this process is longer, please be patient 

 

Step12: After installation, the following interface appears, click "OK" end of the installation of this patch 



 

 

 

 

 

Step13: Next, install the second patch Visual Studio 2005 Service Pack 1 Update for Windows Vista, double-click 

to run VS80sp1-KB932232-X86-ENU.exe, followed by the interface appears as shown in Figure 

 

 

Step14: Wait a moment, appears in Figure interface, click "OK" to continue 

 

Step15: Install the license agreement screen appears, point "I accept" to continue 



 

 

 

Step16: The installation process interface, this process is longer, please be patient 

 

Step17: After installation, the following interface appears, click "OK" end of the installation of this patch 

 

Step18: Next, install the third patch Visual Studio 2005 Service Pack 1 ATL Security Update, double click to run 

VS80sp1-KB971090-X86-INTL.exe, followed by the interface appears as shown in Figure 

 

 



 

 

 

 

 

Step19: Wait a moment, appears in Figure interface, click "OK" to continue 

 

Step20: Install the license agreement screen appears, point "I accept" to continue 



 

 

 

 

Step21: The installation process interface, this process is longer, please be patient 

 

Step22: After installation, the following interface appears, click "OK" end of the installation of this patch 

 

At this point, based on Windows7 Visual Studio 2005 platform and patch has been completely installed. 



 

 

Windows CE 6.0 and install 2.2.2 patch 

Then start the installation of Windows CE 6.0 Platform Builder, Note: On Windows 7 installed on your system 

Windows CE 6.0 and its patch requires administrator privileges to install, do not double-click the installation file 

to run the installation, or to the back can not be installed successfully, please Follow these steps to start the 

installation file. 

Step1: Click "Start" -> "Programs" -> "Accessories", find "command prompt", then right click menu appears, 

click "Run as Administrator", as shown in Figure 

 

Step2: a command line window, enter the appropriate installation directory, and enter the setup program 

name "Windows Embedded 



 

 

CE 6.0.msi ", start the installation, as shown in Figure

 

Step3: in Figure interface, "Next" to continue 



 

 

 

Step4: Enter the product key, "Next" to continue 

 



 

 

Step5: Install the license agreement screen appears, select "I accept",, "Next" to continue 

 

 

Step6: Choose and set the figure, point "Next" to continue 

 



 

 

 

Step7: in Figure interface, select the figure, point "Next" to continue 

 

 



 

 

 

Step8: in Figure interface point "Install" to continue

 

 



 

 

Step9: officially installed as shown, this process takes longer, please be patient 

 

 

Step10: end of the installation, appears in Figure interface point "Finish" to complete the installation. 

 

 



 

 

 

Step11: Next, install the first Windows CE 6.0 patch "Windows Embedded CE 6.0 Platform Builder Service Pack 

1.msi", the beginning of this section in accordance with the method Step1 as an administrator to enter the 

command line window and enter the appropriate directory, enter "Windows Embedded CE 6.0 Platform Builder 

Service Pack 1.msi" to start the installation, as shown in Figure 

 

 

 

 

 

 

 

 

 



 

 

 

 

Step12: in Figure interface, "Next" to continue 

 



 

 

Step13: in Figure interface, choose "I accept", and point "Next" to continue 

 

Step14: in Figure interface, "Next" to continue 

 

 



 

 

Step15: 

officially installed as shown, this process takes longer, please be patient



 

 

 

 



 

 

Step16: end of the installation, appears in Figure interface point "Finish" to complete the installation. 

 

 

Step17: Next, install the Windows CE 6.0 second patch "Windows Embedded CE 6.0 R2.msi", the beginning of 

this section in accordance with the method Step1 as an administrator to enter the command line window and 

enter the appropriate directory, enter "Windows Embedded CE 6.0 R2.msi "to start the installation, as shown in 

Figure 

Note: Some users may download to a separate Windows Embedded CE 6.0 R2.msi "installation file, the size 

of50MB or so, but this patch seems to be incomplete, may encounter when installing a lack of "help.cab" 

documentation, resulting unable to successfully install, we recommend that users use our R2 patch, it is a total 

of 122 files about1.01GB. 



 

 

 

Step18: in Figure interface, "Next" to continue 

 



 

 

 

Step19: in Figure interface, choose "I accept", and point "Next" to continue 

 



 

 

 

Step20: in Figure interface, do not make any changes, "Next" to continue 

 



 

 

 

Step21: in Figure interface, "Next" to continue 

 



 

 

 

Step22: officially installed, this process takes longer, please be patient 



 

 

Step23: end of the installation, appears in Figure interface point "Finish" to end the installation 

 



 

 

Step24: Installing Windows CE 6.0 now the third patch R3, the beginning of this section in accordance with the 

method Step1 as an administrator to enter the command line window and enter the appropriate directory, 

enter "Windows Embedded CE 6.0 R2.msi" to start the installation , as shown in Figure 

Note: Some users may download to a separate Windows Embedded CE 6.0 R3 "installation file, it is actually a 

CD-ROM image file to the user easy to use, we extract it, make an ordinary directory papers, which total 166 

files, size is about 1.14GB 

 

Step25: in Figure interface, "Next" to continue 

 



 

 

 

Step26: in Figure interface, choose "I accept", and point "Next" to continue 

 



 

 

 

Step27: in Figure interface, "Next" to continue 

 



 

 

 

Step28: officially installed, this process takes longer, please be patient 

 

Step29: end of the installation, appears in Figure interface point "Finish" to end the installation 



 

 

 

2.2.3 installation of third-party software Tencent QQ 

In Windows CE 6.0 R3 patch, Microsoft also offers an optional formal third-party software, respectively, 

Tencent QQ and File Viewers, we have put them into the data CD-ROM, users can also download them from the 

Microsoft website at the following address : 

http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=bc247d88-ddb6-4d4aa595-

8eee3556fe46 # filelist (this address may be invalid, please check the user to Microsoft's own Web site) 

We followed the example, the actual used Tencent QQ, so we only install QQ, the user can install other 

software testing. 

Description: 

Step1: enter QQ installation directory, double-click setup.exe to start the installation run, as shown in Figure 



 

 

 

Step2: in Figure interface, "Next" to continue 

 

 



 

 

 

Step3: Use the default configuration, does not make any changes, "Next" to continue 

 

 



 

 

 

Step4: in Figure interface, select "I accpet",, "Next" to continue 

 

 



 

 

 

Step5: in Figure interface, "Next" to continue 

 

 



 

 

 

Step6: in Figure interface, wait a moment 

 

 



 

 

 

Step7: in Figure interface point "Close" to end the installation 

 

 

 



 

 

 

2.2.4 Installing the kernel BSP and example project 

S3C6410-TFA BSP and example project files such as only one installation file S3C6410-TFA-WinCE6-Suite-1030 

(1030 is the suffix identifies the version date in weeks, subject to your CD-ROM), which contains all of the BSP 

source code and core engineering examples, SDK engineering example, users can http://www.esys.ir web sites 

"download" to find the latest version, the following is a detailed installation process. 

Step1: Find S3C6410-TFA-WinCE6-Suite-1030 executable installation file, and double-click to run 

 

 

 



 

 

 

Step2: to keep the settings unchanged, the point "Install" to continue 

 

Step3: the installation process interface, because the installation file is small, the installation will end soon 



 

 

 

 

Step4: end of the installation, appears in Figure interface point "Close" to end the installation 

 

Installed, will WinCE600 \ PLATFORM directory to create SMDK6410 BSP directory, as shown in Figure 



 

 

 

And WinCE600 \ OSDesigns directory to create core sample project file directory, you can see in Figure 3 

directories, which are representative of three languages: 

 S3C6410-TFA - Simplified Chinese 

 S3C6410-TFA-en - English (English) 

 S3C6410-TFA-tw - Chinese Traditional 

 

At this point, Windows CE 6.0 development environment has been completely created. 

3 configure and compile the kernel and Bootloader WindowsCE 6.0 

Because Windows CE6 kernel configuration is more complex, Hen vulnerable configuration does not compile a 

result, we all know Windows CE platform compilation is very time consuming, so we  deliberately made the 

core engineering sample, so for reference, the user according to the following steps can be compiled directly 

open, and CD-ROM images \ WindowsCE6 directory.In the corresponding compiled kernel image file. 



 

 

3.3.1 default kernel compile sample project 

Now, we start to compile just installed VS2005 S3C6410-TFA BSP, VS2005 when you first start to take note of 

some issues, the following steps:  

Step1: Click "Start" -> "Programs" -> "Microsoft Visual Studio 2005" -> "Microsoft Visual 

Studio 2005 "(hereinafter referred to VS2005), as shown in Figure 

 

Step2: prompt window will appear below, please do not point "Continue", where Microsoft recommends that 

you use to run the program as an administrator, so the point of "Exit Visual Studio" to exit. 

 

Step3: We first VS2005 is set to administrator privileges, click "Start" -> "Programs" -> "VS2005"-> "VS2005", 

then right in Figure menu, click "Properties" 



 

 

 

Step4: Figure window appears, click "Compatibility" tab, and check for shown, click "OK" to return. 

 

Step5: At this time point and then "Start" -> "Programs" -> "VS2005" -> "VS2005", just the prompt window will 

appear, as shown, point "Contonue" continue, this time will be run as administrator VS2005 

 



 

 

 

Step6: in Figure interface, which is the VS2005 working interface, this will no longer go into the interface, 

please refer to the user data can be used VS2005 

 

Step7: Point File-> Open-> Project / Solution ..., as shown in Figure 

 

Step8: file selection window appears, find the default kernel S3C6410-TFA project file (path is: C: \ WINCE600 \ 

OSDesigns \ S3C6410-TFA), point "Open" to open it, as shown in Figure 



 

 

 

Step9: Wait a moment, S3C6410-TFA default kernel project workspace is loaded, the interface appears as 

shown in Figure 

 

Step10: Point "Build-> Advanced Build Commands-> Clean Sysgen" to compile the kernel, as shown, this 

process is longer, please be patient 



 

 

 

 

Step11: compile is completed, the results shown in the figure, this time will build the kernel image fileNK.bin 

and NK.nb0, the following path: 

C: \ WINCE600 \ OSDesigns \ S3C6410-TFA \ S3C6410-TFA \ RelDir \ S3C6410-TFA_ARMV4I_Release 

 

3.3.2 modify the BSP type of LCD and serial output 

Description: We offer the BSP model currently supports the following LCD screen: 

  NEC 4.3 "LCD with touch  

  TPO 3.5" LCD with touch  

  Innolux 7 "LCD with touch 

 Sharp 8 "LCD (or compatible) with touch 



 

 

 LCD2VGA adapter module: respectively, 1024x768, 800x600, 640x480 resolutions are  

 EZVGA: an easy VGA adapter plate, support 800x600 (or less) resolution output by modifying \ SMDK6410 \ 
SRC \ INC \ options.h header file LCD_TYPE definition, you can select the appropriate 

The LCD type: 
# Define LCD_N43 - default for NEC4.3 "LCD 
/ / # Define LCD_T35 
/ / # Define LCD_L80 
/ / # Define LCD_A70 
/ / # Define LCD_VGA1024768 
/ / # Define LCD_VGA800600 
/ / # Define LCD_VGA640480 
/ / # Define LCD_EZVGA 
In options.h file, the user can modify the serial output function: as an ordinary function or serial debug output 
(only serial port 1), the following definition: 
/ / --- By customer 
# Define KITL_NONE - the default setting 
/ / # Define KITL_SERIAL_UART0 
/ / # Define KITL_SERIAL_UART1 
The default is defined here as an ordinary serial port functionality (currently there are problems COM1 serial 
port as normal), 1 serial port if you want to use as a debugging information output, it should be defined as: 
/ / # Define KITL_NONE 
# Define KITL_SERIAL_UART0 
/ / # Define KITL_SERIAL_UART1 

 

3.3.3 In line with the BSP configuration precise touch screen 

In order to achieve better touch effect, we deliberately designed the touch-line precision circuit, and integrated 
into the LCD driver board, which uses a professional touch screen controller chip ADS7843 (or compatible), with 
a microcontroller to form an independent four-wire resistance Touch-screen acquisition circuit, allows for 
better data collection, to shake, at last, through a common interface to the GPIO to send out the processed 
data, the development board is connected to PWM1 mouth, in fact we only use it GPIO function, which is 
GPF15. 

We have the touch-line precision driver made dll file (file name touch_1wire.dll) into the BSP, but also need to 
modify the relevant settings before compiling, it can compile WinCE kernel support for front-line precision of 
touch, can follow the steps below to modify settings related to the BSP. 

Open "C: \ WINCE600 \ PLATFORM \ SMDK6410 \ SMDK6410.bat", find the following definition of items, 
probably in the 15 lines: 

set BSP_NOTOUCH = 

set BSP_NOTOUCH_ADC = 1 

set BSP_NOTOUCHCOM = 1  

set BSP_NOTOUCH_1WIRE = 



 

 

How to understand the above definition? 

When the defined term set is empty, the system will support the definition of that term; when set to "1" 

indicates that the system will not compile support this, so if you intend to use the ARM comes with its own 

touch-screen control, This definition of 

If you 

inten

d to 

use 

serial port touch screen controls, you need to be defined as: 

set BSP_NOTOUCH = 

set BSP_NOTOUCH_ADC = 1  

set BSP_NOTOUCHCOM = 

set BSP_NOTOUCH_1WIRE = 1 

In support of this default precision for the touch-line. 

In order to support the front line and not precise WinCE kernel file separate, we add its "-i" suffix, such as CD 

NK_A70-i.bin so, you can compile a serial touch screen controller support kernel file, before we are "-s" at the 

end of a distinction. 

To test the effect of touch, you can use the system comes with a "small brush" software, can be found on the 

desktop, file named "Painter", the test results shown, you can see the writing is very smooth, no jitter. 

 

3.3.4 on the BootLoader 

In Mini2440 system, WindowsCE5 / 6 Bootloader used for the Nboot, it is compiled with the ADS software; in 

S3C6410-TFA, we still put Bootloader named Nboot, but its source code is put together and BSP, need by 

VS2005 to compile. 

 

set BSP_NOTOUCH = 

set BSP_NOTOUCH_ADC = 

set BSP_NOTOUCHCOM = 1 

set BSP_NOTOUCH_1WIRE = 1 



 

 

Nboot source code location: C: \ WINCE600 \ PLATFORM \ SMDK6410 \ SRC \ BOOTLOADER 

This directory contains two Nboot: 

  nbootRAM128: 128M for memory development board platform  

  nbootRAM256: 256M memory for platform development board with these two Nboot will be compiled. 

In terms of functionality, S3C6410-TFA used Nboot and Mini2440 very similar, they are a very simple 

bootloader, its size does not exceed the 8K (Mini2440 the Nboot less than 4K), Nand Flash in general is 

programmed into the position for Block 0 Start WinCE kernel, Nboot reason to Samsung, we have done a lot of 

improvements, currently has the following features: 

support rapid start-up screen display z 

 WinCE kernel support for dynamic loading progress bar 

Quick Start WinCE z 

Note that, Nboot do not have the programming capabilities, it can only read a good deal has been programmed 

file: start-up screen (BootLogo) and WinCE kernel. 

Nboot with Hen easily customizable, you can modify the boot image header file defines the display position, 

background, and the progress bar color, position, length and width, etc., these definitions in the options.h file is 

the header file and BSP shared, which is located SMDK6410 \ SRC \ INC folder. 

# Define KITL_NONE 

/ / # Define KITL_SERIAL_UART0 

/ / # Define KITL_SERIAL_UART1 

 

/ / By changing the definition, select the appropriate LCD models, where the default selection for the NEC 4.3 

"LCD 

# Define LCD_N43 

/ / # Define LCD_T35 

/ / # Define LCD_L80 

/ / # Define LCD_A70 

/ / # Define LCD_VGA1024768 

 

/ / # Define TOUCH_SCREEN_WIDTH 1024 

/ / # Define TOUCH_SCREEN_HEIGHT 768 

 

/ / Set the background color of the boot 

# Define BACKGROUND_R 0x00 

# Define BACKGROUND_G 0x00 

# Define BACKGROUND_B 0x7F 

 

 

/ / Set the color of the progress bar 

# Define PROGRESS_BAR_R 0xFF 

# Define PROGRESS_BAR_G 0xFF 

# Define PROGRESS_BAR_B 0x00 



 

 

 

/ / Set the location of the boot image 

# Define LOGO_POS_TOP 0 

# Define LOGO_POS_LEFT 0 

 

/ / Set the start position and length and width of the 

# Define PROGRESS_BAR_TOP 240 

# Define PROGRESS_BAR_LEFT 50 

# Define PROGRESS_BAR_WIDTH 400 

# Define PROGRESS_BAR_HEIGHT 4 

Compile Nboot 

In fact, the above steps, we have compiled Nboot, available target file: Nboot.nb0, its format and ADS compile 

the bin format is the same, so we need it to be programmed into the development board .This file is located in: 

C: \ WINCE600 \ OSDesigns \ S3C6410-TFA \ S3C6410-TFA \ RelDir \ Samsung_SMDK6410_Release directory. 

Compile a WinCE kernel takes a long time, but you can be compiled separately Nboot, in Figure navigation bar 

to find Nboot source directory, right-click "Build" to separate compilation. 

 

You can generate Nboot.nb0 download via USB or SD card to be programmed into the Nand Flash in its use, see 

Chapter III of the steps. 

3.3.5 Creating SDK 

SDK for: development of the host only when installed VS2005, but did not install the Windows CE 6.0 Platform 

Builder plug-in, when developers want to develop min64140 VS2005 application, you need an SDK, It is similar 

to Embedded Visual C + + required for the SDK. 

When you compiled the kernel by default, then you can create the appropriate platform for VS2005 SDK, Note: 

This only applies to VS2005 SDK development environment, it can not install the EVC, can not install VS2008, 

the following is the detailed steps to create the SDK . 



 

 

Step1: Run VS2005 and open the default kernel has been compiled sample project S3C6410-TFA, find the 

location shown, and right-click "S3C6410-TFA-CE6-SDK" menu appears, point to start creating SDK Build 

 

Step2: Wait a moment, SDK has been created, as shown 

 

Step3: In the C: \ WINCE600 \ OSDesigns \ S3C6410-TFA \ S3C6410-TFA \ SDKs \ S3C6410-TFAsdk directory, you 

can see has been generated S3C6410-TFA-CE6-SDK.msi installation file 



 

 

 

Install the SDK 3.3.6 

Tip: If you do not want to produce their own generation SDK, ready-made CD-ROM has been included in the 

SDK installer, which is located in: WindowsCE6 \ S3C6410-TFA-SDK.msi 

VS2005 is S3C6410-TFA development through application of production need to install just the SDK, follow 

these steps 

Step1: Double click S3C6410-TFA-SDK.msi, there are interface,, "Next" to continue 

 

Step2: Figure choose "I accept",, "Next" to continue 



 

 

 

Step3: in Figure interface, enter the user name and company name, point "Next" to continue 

 

Step4: in Figure interface point "Complete" to continue 

 



 

 

Step5: in Figure interface, "Next" to continue 

 

Step6: in Figure interface point "Install" to continue 

 

Step7: installation progress screen appears as shown in Figure, wait a moment 

 



 

 

 

Step8: the end of the installation interface, point "Finish" the end of 

 

Thus, SDK is already installed. 

 


